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This tutorial is for the creation of Low-Poly "Portable 
Game Res" real-time characters. This tutorial is being 
made with 3D Studio Max and Photoshop and all 
program-specific instructions are for those programs. 
The basic techniques can be transfered to other 
applications if you are already very familiar with those 
program.  

The first thing you should ever do befor even opening 
your 3D app, is to get your ref ready. I wasn't aiming for 
anything fancy or elaborate. Nothing fantasy or sci-fi. 
Just a guy. So I'm using photo ref. A well-drawn, and 
proportionally accurate drawing is also a good option. 
If you are not confident in your drawing ability, either get 
someone else to draw your ref, download a drawing, or 
just use photographs.  

This is the guy I'm using. It's actually a compilation of 



two different guys, in order to get the clothing I liked.  

. 

 

(Right-click and save link as for higher-res versions of these)  

These images came from 3d.sk. It is probably the best source I've ever encountered 
of human reference. It's great for anatomy, for clothing, for textures, etc. etc. etc.... It 
is however a PAY SITE and it is sort of expensive.... Team up with some friends and 
pay for one month and each of you can power-download and try to grab everything 
you can from the site before your subscription runs out.  

A Couple Tips for your Reference Images: - Make sure your reference images are 
the exact same size and that the images line up with each other. 
- I've found it's best if your reference images are squares, so even if you don't need 



all that extra space, still include it. 
- Make sure that everything is in the exact center of the image file. Especially the 
front or back images. 
- Mirror your image to make sure it'll look right when modeled with symmetry. 
- Make sure that the background color of your reference image is not white or very 
light gray. As you can see in 3dsmax, the wireframe usually shows up as white, and 
if your background is white too, it makes it very difficult to work!  

 
Setting up the Viewports 

1. Open 3dsmax 
2. Your screen should have a 4-viewport split (top, front, left, and perspective). Click 
in Front. 
3. Go to Views > Viewport Background (or press Alt+B) 
4. Click the "Files..." button and find your front reference image. 
5. In the Aspect Ration area (bottom left) choose Match Bitmap. 
6. To the right, Check "Lock Zoom/Pan 
7. Click OK and Repeat for the Left Viewport. 

The Window Should Look like this -  

 
 

Before we really get started, I want to explain a few things in hopes that you won't 
get lost later. To the left of the screen is a set of tabs. Each of these lets you access 



a different set of important tools and features in 3d studio max.  

 

The First one is Create 
- In Create you can make a bunch of primitive objects. Box, Sphere, Cone, etc. 
There is a drop-down menu at the top (Says Standard Primities by default). If you 
change this, there are other types of things that you can create. In the newer 
versions of max, you can even create stairs, and trees, and other automatic objects 
here. But all we care about right now is the Box. But we'll get to that in a minute...  

The Second Tab is Modify 

- You will spend most of your time in this tab. It is where you can actually MODEL.  

The Third Tab is Hierarchy 
- This tab will be important in our tutorial when we use the symmetry modifer to 
mirror the model. The location of the model's pivot is very important to making 
things like symmetry and mirror work. You can click the Affect Pivot Only button, and 
move an objects pivot to Zero and then symmetry will work.  

The Forth Tab is Motion 
- If you rig your character using Biped, all of the biped options will display here. 
There are a lot of things you can do in here, but only when doing specific tools or 
doing specific things that involve animation and controllers. Nothing too important to 
what we're doing in this tutorial.  

The Fifth Tab is Display 
- You can hide objects, freeze them (makes it so you can't select them, but they're 
still visible), and change the display properties of an object here.  

The Sixth Tab is Utilities 
- Some utilities are more useful then others. One thing of use you can find here is 
the poly counter. If you click on the More button a list will appear and Polygon 
Counter should be in the list. This will let you check what your character's poly count 
is.  

 

Lets Start  



1. Go to the Create Tab and click on Box. 
2. In the Front viewport draw a box around the shoe. Set the Length, Width, and 
Height Segs to 1. 
- I always just use a straight up plain box to start. And I prefer to start with one that 
doesn't have any segments in it already, since I judge how many I need by the 
reference image. 
3. Go to the Modify Tab 
4. Right-Click on the word Box and convert to Editable Poly 

 
Click Image to View Larger  

Now you have a whole bunch of new stuff, where before 
you just had the parameters of the box. By default you 
won't see this list - you have to click on the little + sign 
before the words Editable Poly. Do that now. 

For the total newbs reading this, the Verticies (vertex) are 
the dots, Edge is pretty self-explanitory, Border will select 
all the edges on an external border that you click on, 
Polygon are the faces of the model - the squares/triangles 



that make up the surface (you should avoid n-gons in your geometry at all costs. An 
n-gon is a polygon with more then 4 sides.) And element will select the entire object.  

You can also change selection type by clicking on the icons just below the word 
"Selection".  

USEFUL TIP MOST PEOPLE DON'T KNOW! 
If you have a selection of one type, you can convert that selection to another type by 
holding down the Ctrl Key and clicking on one of the other type's icons under 
Selection. Example: You have a group of Polys selected, hold down Ctrl and click on 
the Vertex icon and your selection is converted to all of the verts that made up the 
polys you had selected.  

 

The options and tools available in the edit poly modifier will differ depending on what 
you have selected. These are the most important tools that you will use over and 
over and over again while modeling.  

 

The image on the left shows what tools are available if you are in the Edges 
selection, and the image on the right shows the tools for Vertices. You will find that 
you often use Remove, Bride, Connect, Chamfer, Target Weld, and Weld.  

Some of the tools have a box icon next to them. With these, if you click the box 
instead of the main button, you will get a window that opens with several options to 
choose from. You will click the box most often. Clicking the button will use the tool 
with either the default settings, or whatever settings you entered into the box last.  

 

Go to vertex select mode, and grab the verts of the back of the box in the left 
viewport and pull them back to the heel.  

Go to edge select mode and select the verticle edges (the front and back of the foot) 
and click the box next to the Connect tool. The window pops up - we only need one 
segment right now, so the defaults are fine.  



 

In the Top View select the edges along the heel and toe and repeat. Now you've 
made a division down the center of the side and top of the foot. From the top now 
select the sides of the foot and click the button next to connect, this time we want 2 
segments.  

Go back to vertex mode now and start moving things around in the different 
viewports so it matches the shape of the foot. Switch between the side and top 
viewports to get the shape better. For the part of the foot where it starts coming up in 
the front, I select the edges along the top of the foot, but not the bottom and hit 
connect (only 1 segment) then connected the edge verts to one of the near verts to 
avoid n-gons.  



 

Go to the Perspective Viewport now and take a look at the foot. Obviously it's not 
gonna be quite right, but it's closer. Start bringing in areas like the top of the shoe, 
around the heel, etc.  

 

The temptation will be to start adding more geometry so you can match the shape 



better, but TRY NOT TO. You will add detail with the texture. Think of this as a big 
lump of clay and you're just aiming to get the general mass and shape of the object. 
Try to achieve the best shape you can with as little geometry as possible. There's no 
point waisting a bunch of verts on the feet when you've got a tight budget.  

 

But Some new geometry is sometimes nessecary... I decided that I wanted to define 
the heel of the shoe, so I selected the edges circled above and clicked connect with 
the box. Change segments to 2 and adjust the values of Slide and Pinch so that it's 
closer to the actual heel. Then select one row of verts and pull them up.  

Make sure to connect the new verts to other verts to avoide n-gons. Tris (3-sided 
polys) are okay, Quads (4-sided polys) are okay, but not 5 or more.  

 

Check all the various angles frequently to judge if you're getting the volume and 
shape right.  

Smoothing Groups 

3D Studio Max uses smoothing groups to make low-poly geometry look smooth. In 
Real-time it's called "Normal Smoothing". Most all 3D apps have the feature, but 
each call it something different. (In Maya it's just Hard or Soft Edges for example)  

To control the smoothing groups you have to be in Polygon select mode. Select a 
group of polys (or your entire mesh if you want) and scroll down in the Polygon 
modifing area until you see the Polygon Properties rollout.  



The smoothing groups area looks like a grid of numbers. 
Each number is a group that will be smoothed together. If 
you select a group of polys and you see several numbers 
grayed out that means that these polys do not all share the 
same groups.  

For the foot, first select all of the polys and click the Clear 
All button. The model will now look completely faceted.  

Now select just the heel, and the ball of the shoe (but not the 
indent) and click the 1 button.  

Now select just the indent and click the 2 button. Now select 
the rest of the shoe and click the 3 button.  

You've now assigned smoothing groups. 
The shoes are one of the few areas will I will seperate out areas for groups. For 
most of the model, I will have the entire mesh all be assigned to a single smoothing 
group.  

 

Once you're satisfied with the shape of the shoe, select the polys that make up the 
top border and delete them. Then go to Border select mode and click on the open 
edge.  



 

Now go to the Left viewport, HOLD DOWN SHIFT and MOVE the edges up. Instead 
of moving them, it has created new polys!  

 

Do this a few more times, going up the lege to around the knee. Remember, the 
fewer edges you need to get the correct shape, the better. We're just working the left 
viewport right now, we will move to the front viewport in a moment but first, lets add 
in a few small details...  



 

A lot of people feel like they need to add in an entire row of edges for every little 
detail, but that's a waste. We want a little bit of geometry for the major wrinkles near 
the bottom of the pant leg, but don't need an entire row of edges for it.  

Select the front edges and click connect and adjust the slide so that the new 
edges are lower. 
Connect the edge verts to an existing vert to avoide n-gons. 
Move the new verts outward to closer fit the contour of the leg.  

go ahead and do this around the knee area as well. Once you've got the side going 
up just past the knee and are happy with the basic shape, switch to the front view.  



 

Yikes! Okay... so it looks funky, That's okay! Just start moving things around so they 
line up a little better from the front viewport. Remember things won't be perfect, but 
get it close.  

Another useful and essential tool for poly modeling is the Cut 
Tool. To get to it, you need to scroll further down in the 
editable poly modifier tools then the standard edit vert / edit 
edge area. It's under the Edit Geometry Rollout.  

Cut will let you cut new edges directly on the surface of your 
model. It's usually most useful in the perspective viewport.  

Something to watch for though! It's common to think you've clicked on an already 
existing vert and cut a new edge, but max thinks that you clicked just off the vert and 
has created a new vert. So even though you can't really see it, you now have two 
verts sitting right next to each other. When this happens just select the verts and 
Weld with a high threshold so that the two verts are welded together.  



 

I cut this edge along the bottom of the pants cuff and then pulled the edges out to 
give the bottom of the pants more volume. You should also use cut in other areas 
around the pants to define other wrinkles and deformations in the shape of the cloth. 
Remember though! Don't go overboard. Just very basic volume defining changes.  

Once you're satisfied with the shape of the legs so far, return to Border selection 
mode and select the top of the legs. Once again, Hold Down Shift and move 
upwards a few times for the upper legs.  

My plan is for the shirt and pants to be seperate meshes. The jacket is very baggy 
and extends over the pants a lot, so the two objects will not connect directly. 
Because of this, I need some of the pant geometry to continue up under the jacket. 
This is especially important for when the character is rigged and animated. It's 
important that a big empty gap shouldn't appear under the jacket.  



 

Shape the edges in the front viewport to match the legs better. It is ideal to have a V-
shpe coming from the groin area. It will deform a lot better if you do this.  



 

For the Groin area, I selected the inner edges, held down Shift and moved them to 
the side to extrude new faces. Then I selected the bottom verts (circled in image) 
and clicked the REMOVE button. The remaining verts need to be moved to the exact 
center. Select a single vert and at the bottom of the max window under the 
animation timeline are three areas where you can enter numbers. Change the X axis 
location of the vert to 0. This will move the vert to the center. Do this for all of the 
verts you have here in the center of the groin.  

 

Switch to the Perspective viewport and start tweaking and fixing all of the the shape 
problems that are bound to be there. If any side looks really flat, just bring in the 
edges more to round it out some. You also need to attend to the butt. This area will 



require some cutting and a lot of small adjustments to get it to look okay. In this 
model isn't not a huge deal if it looks perfect since it will be mostly covered by the 
jacket, but it's still a good idea to get the geometry fairly clean on it.  

 

Chances are that the leg is very faceted at this point, so lets do the smoothing 
groups thing again to smooth out our leg. Go to Polygon select mode and select the 
whole pant leg and set it to smoothing group 4. Rotate around the leg and clean up 
any problems you can see with the mesh.  

Now it's time for Symmetry.  

Go to the Heiarchy tab. Closer to the bottom are these two buttons. Click them both. 

 

Now at the top there is a button that says Affect Pivot Only. Click that button. The 
move cursor will change a little to show that now you are controlling the pivot. In the 
X Axis entry at the bottom of the screen, set it to 0. Now the model's Pivot is in the 
exact center.  



 

Return to the Modify tab and click on the drop-down menu that says "Modifier List".  

Scroll way down towards the bottom and find the modifier called Symmetry. If you're 
model suddenly disapears check "Flip". If it's doing symmetry from the wrong 
directly, toggle through the Mirror Axis until you get the right one.  



 

Now is a good time to go and fix any screaming errors that only now make 
themselves apparant. You can go back to the Editable Poly and continue working on 
the model with the symmetry modifier on the top of the stack. But when you go back 
to editable poly, suddenly you won't have the symmetry anymore! But we can fix 
that! There is a set of icons directly under Editable Poly, but above the parameters. 
The 2nd button is "show end result". If you click this button, it will show the 
symmetry, even when working in the Editable Poly area.  

 
 

Starting the Jacket  



Since the Jacket is going to be a seperate object, I'm not just going to extrude it from 
the pants like I did the pants from the shoes. But I don't want to start from a box 
either. So I selected the edges along the top of the pants and held down SHIFT and 
pulled up to create a new row of polys. I went into Polygon edit mode, selected the 
new row and clicked the DETACH button.  

 

At this point you will still have the legs selected. Deselect the legs and select the 
new detached object you just created. Go into vertex mode and start moving the 
vets so that it matches the reference. Also check the side view to adjust for that as 
well.  

 

Select the edges along the top and use the Shift+Move technique to create new sets 
of faces. Make sure the center verts stay at x:0 so that the shirt won't end up with 
holes in it when you apply symmetry to it.  



 

When you go into perspective view you'll probably see some problems - certain parts 
may not have enough edges and others may have too many. To remove a row of 
edges first select the edges and click the remove button, but THEN you need to go 
to vert select mode and remove the left over verts that used to make up the edges. 
Just select any isolated verts and click the remove button.  

To add in new rows of edges, just select the edges edges you want to make a new 
edge between and click the connect button.  

 

Instead of just continuing upwards, at this point I decided to get the neck setup so 



that I could build between the two. 

I went into polygon select mode, selected the top row of polys and held down SHIFT 
and moved them up towards the neck.  

Instead of extruding new polys, like what happens when you hold shift on edges, this 
simply makes an exact copy of the polys you had selected.  

 

I adjusted the verts so they lined up in the front and side viewports and then went 
into perspective view and cleaned up their locations.  

In addition to basic clean-up, I also removed a few edges (remember when you 
remove an edge, you also need to go in and remove the verts too). The amount of 
edges that were present lower in the torso weren't nessecary for the collar.  

 

At this point I did two things to help me continue working. I applied symmetry so I 
could judge the total mass better, and I applied smoothing groups so that it wouldn't 
be faceted anymore. Just do it the exact same way we did above (For smoothing, 
just select all of the polys and pick a smoothing group number; for symmetry click on 



the Modifier List drop-down and scroll towards the bottom where it says Symmetry).  

 

Now to fill the gap between the bottom of the shirt and the collar. Select the bottom 
portion of the shirt's top row of edges and hold shift and pull them up. Adjust the 
verts in the front and side views so that they come to the bottom of the armpit.  

 



Next select just the front and back edges, and skip the edges that make up the 
bottom of the arm hole. Hold shift and pull just those edges up. Do it again another 
one or two times as needed, checking both front and side views to line up with the 
reference, and then the perspective view to more accurately shape it as needed.  

 

Doing the shoulders and connecting to the collar can be tricky. Instead of bring up 
an entire row of edges, I selcted JUST the edge circled below. Same as always, just 
hold down SHIFT and drag the edge to create new faces. Then in vertex mode, I 
clicked the Target Weld button and dragged the verts along the top of those edges 
to the base of the collar.  

For the two edges shown selected in the image, I used Bridge. When you have two 
edges selected and you click Bridge it will create a new poly between the two 
edges.  



 

Use Bridge on the remaining edges on the front of the shirt and in the back where 
you can to fill the gaps. Weld any verts together that you need to, and cut in any new 
edges where needed to make it work.  

 

For this part, I find it's best to just work in the perspective viewport so you have a 
better feeling for what you need to fix and adjust.  



 

For the Back, the number of edges didn't match perfectly so I had to do some cutting 
to make it all fit correctly.  

 

Now is a good time to look your model over and see if there are any areas that you 
can optomize. Any place where you've got several edges close together where you 
could probably do just as good with fewer. Just remember that any edges you 
remove, you also have to remove any isolated verties by selecting them afterwards 
and clicking the remove button.  



 

If you need to, select all the polys and set them all to the same smoothing group 
again. Using Bridge tends to add extra smoothing group info that you can get rid of 
by clicking Clear All and then assigning a smoothing group to everything again.  



 
 

Onto the Sleeves  

In Border select mode, click on the edge opening for the arm, and then switch to the 
front view and hold down SHIFT and pull outwards to start the sleeve.  

 



I moved the edges down a bit and rotated them to an angle. Then I selected just the 
top sleeve edges and connected just them. In vert select mode, I selected the new 
edge vert and connected it to existing verts (make sure to switch to perspective and 
check the back to make sure to connect it properly there).  

Then in Vertex select mode I moved the verticies around so that they fit the shape of 
the arm better. Once I had the shoulder started, I selected the border of the sleeve 
and while holding down SHIFT I pulled it furhter down.  

 

Continue working your way down, and use scale on the selected edges when you 
need to make them smaller because this will make them smaller from other angles 
as well and reduce the amount of fixing you'll need to do from the top/side views.  

It's hard to get a good second angle on the arm so you'll have to do a lot of tweaking 
in perspective.  



 

Another important thing to take into account is how the arm will deform when rigged 
and animated. With this baggy simple sleeve, a lot of geometry really isn't needed, 
but if you have too little geometry in the joints, they will deform poorly. I decided that 
I needed one more loop at the elbow, so i selected the edges just below the elbow 

and clicked connect and adjusted the Slide so that the new edge was created near 
the elbow.  

 

Time for some more optomizing!  

When you're tight for polys, any extra or not-totally-nessecary edges are important to 
remove. The arm has a lot of edges going around it - more then it needs, so I went 
back in and started welding together any areas that could afford it.  



 

Do a general all-over pass for anything you can optomize or tweak at this point, and 
set the smoothing groups on the sleeve.  



 

Okay, I know this is a big jump... and I'm sorry, but I 
honestly didn't feel like including a 'how to make a head' 
tutorial in with all the rest of the stuff I'm covering here. 
There are a gazillion 'face modeling tutorials' out there 
already... in fact, I, even wrote one already. So use one 
of them...  

A few things to point out - There are no holes in this 
head for the mouth or eyes. It depends a lot on the 
game, and what the goals are, but a lot of very low-poly 
characters for games just have the eyes textured 
straight on the geometry with the rest of the face. Not 
actual geometry eyes. Having them painted directly in 
the texture tends to look better with really low-poly 
characters anyways, plus it uses a LOT less geometry.  

If this character was going to need to talk during cut-scenes, I'd set it up with a 
mouth that could open and some very simple geometry for the interior of the mouth, 
but I'm not going to bother with that here.  

One other thing to point out is that I selected the collar of the jacket and pulled in 



some faces so that it's not just a floating flat poly edge anymore.  

 

So on to the Hands  

Most all of the hands detail is going to be in the texture. I'm going to leave the ring 
and pinky fingers connected to save polys, and have the hand in a loose slightly-
curled position. This is using the asumption that the hand will not be animated. In 
this positon the character can look like it's hand is just relaxed, but it can also look 
like the character is holding something.  

Off to the side of the character, go to the top viewport and make a box. The box 
should be short in depth, and nearly square from the top view.  

Select the two edges of one of the sides and connect with TWO SEGMENTS. Go 
to vertex mode and move the newly created edges so that the first two parts ar 
about the same size, and the last one is larger.  

Select the three faces that now exist on this side and click the Bevel button and in 
Bevel Type, choose By Polygon so that it's extruding three seperate segments 
instead of one large one.  

 

Go into vertex edit mode and adjust the size and shapes of the digets so that they 
more closely resemble the appropriate lengths for fingers.  

Select the edges of all the fingers and connect so that you now have a new edge in 
the center of each finger.  

Switch to perspective view and along the top of each finger Cut it so that there are 
two edges along the top, and it connects to the single edge like a V like in the image 
below. Do this for each finger.  



 

Do this again to create the 2nd set of joints on the fingers, then go to the perspective 
viewport and select all the verts in the lower half of the finger, and ONE pair of verts 
from the top joint, and rotate the finger downloads (you'll have to move the verts so 
they line up correctly after you use rotate).  

Do it so it looks like the image below.  

 

Repeat this on the 2nd knuckle, and do it for the other fingers.  



 

Next select the edges on the side of the hand that would have the thumb and 
connect them and pull that edge outwards. Select the face where the thumb would 
exturde from and do a bevel from it. Connect the edges in it to create the joint.  

Use Cut to cut in more detail along the top and bottom of the hand itself. Remember 
N-Gons are no-nos, so any but funky polys that we created need to be cut up into 
quads and tris.  

 

Once you're satisfied with the hand, move, rotate, and scale it so that it fits with the 



rest of the body. Go to the Hiearchy Tab and click the Reset Transform and Scale 
buttons, then the Affect Pivot Only button and in the axis number entry at the 
bottom center of the screen, set X to 0.  

 

Now you can apply Symmetry to the hand and it'll appear on both sides of the body.  

 
 

Now to Unwrap it!  

Most people learn to unwrap all/most of the 
character on to one huge unwrap sheet. It's how 
I learned it, and until I actually started working in 
a real game studio, it was the way I always did 
it. One big texture sheet is not a very good idea 
for us though. There are a few reasons. First of 
all, the largest texture size that we were ever 
allowed to use when working on PS2 was 



256x256. The largest texture size we've ever been able to use on PSP is only 
128x128. Now when you're texture can only be 128x128 in size, sqeezing the entire 
charater into that space will result in very blurry low-res textures.  

So instead, we segment the character up into pieces and each piece gets it's own 
unwrap and it's own texture. 

The Shoes get a 64x64 map. The legs get a 128x128. The torso gets a 128x128, the 
arms get a 128x128, the hands get a 64x64 and the head gets a 128x128.  

Some would agrue that it costs more power for the engine to read multiple textures, 
but that difference is nominal, and when the visual result is significantly better, it's 
worth it.  

Another reason a studio might have for having each piece have seperate textures is 
if they were using a swapable part system, or custimizable characters. Then having 
each piece with it's own texture is the best idea anyways.  

 

So, with this in mind, I split the character up into a few pieces.  

 



named them "Shoes") or you can leave it alone, it's up to you. I did the same thing 
with the sleeves, and named them "Arms".  

Once all the pieces are seperated, I got the unwrapping texture ready. I use a simple 
checkerboard texture. Some people get more elaborate, having multi-colored 
squares with numbers or letters in them (it makes it easier to see if something needs 
to be flipped horizontal if you have numbers, etc. in the squares) but in this case, I 
don't feel anything too special is nessecary.  

Open the Material Editor by pressing the M key. Choose any blank material sphere 
and click the little Square button next to Diffuse. A list will appear and from it, choose 
"Bitmap" and then it will open the standard windows file finder and you can pick 
your texture here. Above I have the checkerboard I use, you can save it and use it.  

 

Once you have the material setup, click the button in the material editor (in row of 
buttons along top, just under all the spheres) so that the texture will show in the 

viewport. Then Select all of the parts of the character and click the assign button 
to assign the material to those objects.  



 

The result will look something like the image above. The objects don't currently have 
any UV unwrapping done to them, so everything is a mess. This makes the texture 
appear all stretched and distorted on the object.  

Lets Start with the foot again. Select the foot. If you still had the symmetry modifier 
on the legs and had not collapsed it yet, then yo should only have one foot that isn't 
symmetried here. That's good - we can throw a symmetry on this later after we've 
unwrapped it.  

If you do have both feet, and no symmetry, go to element select mode, select one of 
the feet and delete it.  

Okay, now, make sure that you click on the word Editable poly and make sure none 
of the sub-selection types is selected (make sure you aren't in vertex, element, etc. 
mode)  

Click on the Modifier List drop-down and scroll towards the 
bottom and find the modifier called "Unwrap UVW".  

It should look like the image below, with a + sign in front of 
the word Unwrap UVW. Click on the plus sign to expand it 
and see the sub selection options.  

IF YOU DON'T HAVE A PLUS SIGN that means that when 
you applied the modifier, you were in one of the sub-selection 
types for edit poly (you were in vertex select mode, or one of 
the others). Just delete the unwrap modifier and do it over, 



making sure you aren't in any of the sub-selection modes.  

Once you have the Unwrap modifier on, Scroll down enough until you see the big 
Edit button. Click this button and it will open a window that shows you what your 
unwrapped UVs look like. Right now it probably looks like a mess, but don't worry. If 
you have dual-monitors, it's best if you can put this window on the other screen. If 
you don't, size it to a shape that you can work with it, but still work in the main max 
window. If you have to, minimize the edit window and then open it back up when you 
are ready to use it.  

If you scroll further down in the unwrap modifier you'll see a section of Map 
Parameters. We will be using Planer and Cylindrical fur this character.  

Make sure you are in Face select mode under Unwrap UVW and select the polys of 
the bottom of the shoe. You can toggle between solid red and slightly opaque red by 
pressing the F2 button. This will allow you to more easily see what polys you have 
selected (solid red) or make it so you can see the checker texture that's applied to 
the polys (opaque red).  

 

Once you have the polys selected, click the planar button.  

A yellow square will appear around the selected polys. It may be on the wrong axis 
though, so click the Align X, Y, or Z buttons until you get the planar on the correct 
axis.  

While the Planar button is still active (yellow) you can manipulate the yellow 
projection square's size, angle, and location with the normal move, rotate and scale 
tools. Scale the box until it looks like it's a perfect square (don't worry about being a 
perfect square, but you do want it square). If you gottle to the opaque red (F2) so 
you can see the checker texture, you'll see why it's important to get the projection 
gizmo to be a square. If the gizmo isn't square, neither is the texture. When done 
adjusting the gizmo, just click the Planar button to deactive it, and then you can 
select more faces.  



 

Next I selected the polys that make up the heel and applied a Cylindrical map (click 
the Cylindrical button). Change the Axis that it's aligned to until you find the right 
now. Now move and scale the gizmo (just use the regular move and scale tools) so 
it's on the heel correctly. Toggle F2 to see the checkerboard texture, and scale the 
cylidrical map gizmo until the checkers are squares. When done, click the Cylindrical 
button again to deactivate it.  

 

Next I selected the rest of the shoe and did a planar map down the center of the 
foot. Again, toggle between F2 so you can see the texture and scale the gizmo so 
that the checker texture looks square, and the squares are approximately the same 
size as the squares on the rest of the shoe.  



 

And finally, I selected the top of the shoe and did another planar map on it. Rotate 
the plane so that it's going at about the same general angle as the top of the foot.  

Now that we've done all of the projections we can go into the Edit window and start 
moving the UVs around themselves. 

Along the bottom of the Edit UVWs window should be a bar that looks like the one 
below. I've circled the things that you'll frequently use from this window.  

 

When you first go to edit the UVs after having made several projections, most 
everything will probably be overlapping. If you check the "Select Element" option, 
and select just a single vert of an unwrapped part, it will select the entire part 
automatically. This makes it easy to then move that pice away from the mess in the 
middle, so you can seperate everything and start working on it.  

When you're ready to edit the individual UVs (vertices) make sure to uncheck this 
option.  

The Rot. +90 and Rot. -90 options are often useful for rotating and entire object a set 
90 degrees in one direction or another, so they're useful too.  

 

There is also a set of buttons along the top of the edit window. Move, Rotate, Scale 
are pretty self-explanitory. The 3rd button (highlighted in the image below) is 
Freeform Mode and basically allows you to move, rotate, and scale, all in one, 
depending on where you click on the gizmo that appears. It is a very useful tool. It 
also gives you more control when scaling something.  

Next to the Freeoform tool is Mirror. The difault will flip your selection horizontally. If 



you hold down on the button you can choose to flip vertically instead.  

And further to the right in the windows is a box icon with checkers on it. Right now 
your edit window probably has the checkerboard texture in the background and it's 
making it difficult to see the UVs. If you click this button, it will turn off the texture 
preview in this window.  

 

If you're still in Face select mode under the UnwrapUVW modifier, switch to Verticies 
now. I started out by selecting each part by element and seperating them in the 
window space so I could sort them out. Then I turned off select by element.  

I moved, rotated, and scaled (I used the freeform tool) the cylindrically unwrapped 
heel so that it lined up with the side unwrap of the main shoe. I used Target Weld 
(Ctrl + T or Tools > Target Weld) to connect the edges together.  

I also freeform moved the top of the shoe so that it lined up with the side of the shoe. 

Since I have no need for the heel to be totally unwrapped like that, I'm going to 
select half it (the part circled in red) and detach it from the rest of the heel (Ctrl+D or 
Tools > Detach Edge Verts) and then Flip it horizontally and move it over top of the 
other half of the heel.  



 

Using Target Weld (Ctrl+T) I attach all verts together that are close and should 
share UV space. This helps me line up seams in the texture later, as well as keeping 
my UVs clean.  

 

Once I've got all the pieces cleaned up and welded together the way I want, I move, 
rotate and scale all of the pieces into the bold square. This is the space that will 
make up the actual unwrap, so everything needs to be inside this square.  

Now all that's left is to render out the UV Template to an image so that you can open 
it in photoshop. To do that go to: 
Tools > Render UVW Template  

A Render UV's window will pop up. Change the Width and Height to whatever size 
you want (The textures should be twice that of the res you intend to use in the end. 
Since I plan for my final texture for the shoes to be 128x128, I made it render the 
UVs at 256x256.  

I also changed the color for the Seam Edges to white (it defaults to neon green).  

Click the Render UV Template button and the Render Map window will pop up. Click 



the little Save icon (looks like a floppy disc) and choose where you want to save it, 
name it, and pick a file format. We always use TGA files since you can save an 
alpha chanel in them, so that's what I'm using here (32 bit means it's saving an alpha 
chanel).  

 

Once you've done this, you are finished unwrapping the foot so you can close the 
edit window. Click on Unwrap UVW so you're on the top of the stack and from the 
Modifier List scroll towards the bottom and find Symmetry. Choose the correct axis 
to mirror from and once the shoes are mirrored properly right-click on the modifier 
Symmetry in the modifier stack and choose Collapse All from the drop-down.  

 

Next lets select the Leg. With Editable Poly selected (but none of it's sub-selection 
types, and not the symmetry modifier on top) add a Unwrap UVW Modifier to it, but 
UNDER the symmetry modifier.  

Click the + button next to Unwrap UVW and select Face selection mode. Select the 
entire leg and click the Cylindrical button.  



 

While the Cylindrical button is still active, move, rotate, and scale the projection 
gizmo so that it matches the leg better. Make sure it's tilted good from both front and 
side angles.  

Also make sure to check whether or not the checker texture looks square. With a leg 
you will always get a little distoration variation but try to get it so at least most of it 
looks fairly square.  

 

Now Click the Edit button to open the Edit UVs window and switch to Verticies select 
mode under the Unwrap UVW Modifier. 



Chances are you've got some tags sticking out on one side or the other of the 
unwrap. The goal is to have the seam going down the inner side of the leg, and have 
no little bits sticking out. Select any tags and detach them (Ctrl+D) and move them to 
the other side and weld them in (Ctrl+W).  

Also, if the place where the seam is from the start, is somewhere other then the 
inner leg edge, select the row ofo faces and move it to the other side so that the 
seam is moved. When you're done it should look something like the image below.  

 

Again, Render a UV Template and save the file. Close the edit window, and right-
click on the Symmetry modifier and choose Collapse All.  

Next is the torso  

For the torso, we'll do it a little different. Instead of unwrapping and then adding 
symmetry on top, we'll unwrap the whole torso already mirrored. So you can right-
click on the symmetry modifier and collapse all right now.  

It's a lot easier to hide symmetrical textures on the legs or shoes then it is to hide 
them on the front of a shirt. Perfectly symmetrical cloth wrinkles on a shirt front often 
look bad, so we're only going to mirror portions of the texture.  

Start out by putting an Unwrap UVW modifier on the toros, expand the + sign so you 
can select Face, select the entire model and click the Cylindrical button. Move and 
Scale the gizmo so that it fits the torso as best as possible.  



 

Next change to Verticies select mode, and click the Edit button.  

My plan is to mirror the sides and the back, but leave the front as it is. First I 
selected half the back, detached it (Ctrl+D) and then Flipped it horizontally and 
moved it over top of the other half of the back.  

 



 

Next I selected the half of the side on the right that I wanted to share UVs with the 
other half. I Detached them (Ctrl+D) Flipped them horizontally, and moved them over 
to the portion of the other side that matched them.  

 

There was one more thing I needed to tweak on it before I could consider it done. 
The faces that make up the shoulder are very small in the UV unwrap because 
they're at an angle from where the projection was coming from, so they're very 
stretched in comparrison to the rest. So I selected the verts of the collar and pulled 
them upwards to increase the length of the UVs for the shoulders.  



 

 

Once I'm satisfied with the unwrap I fit it into the square, render a UV image, save it, 
close the edit window, and right-click on the Unwrap UVW modifier and choose 
Collapse All.  

 

And now we move onto the Arm. 
So select the arm. It should be by itself since we detached it from the torso. You can 
wait until you're done with the unwrapping to put a symmetry modifier on it. For now 
put the Unwrap UVW modifier on it from the Modifier List, expand the + and click 
Face selection mode and select the entire arm.  



 

Click the Cylindrical button. None of the automatic axis will actually line up with the 
arm's angle. Instead rotate and move the gizmo until it's about the correct angle and 
then click the Fit button and it'll hug the arm better. Check from multiple angles to 
see if you're getting the best angle on the arm.  

Also remember to scale (make sure it's set to scale on Local Axis) so the checkers 
are closer to square.  

 

When you've got the gizmo to the best size and shape you can, click the cylindrical 
button again to deactivate it and click the edit button to open the UV Edit window.  



Just like with the pants, the edge that's in the center of the inner side is the one that 
we want the seam to fall on. Go to verticies selection and select any faces that are 
on on the wrong side of the seam that should be on the other side, Detach (Ctrl+D) 
and Move them to the other side.  

 

Clean up any stretching or squished areas, and when you're done, freeform 
transform it into the square, render the UV texture out, Save it, close the edit 
window, and collapse the stack.  

 

Onto the hands! 
The hand will be much harder to unwrap then the previous objects we've done up to 
this point. It has a lot more little tweaking. Just use all of the knowledge that you've 
gained up to this point on the previous parts and do your best. And remember, it 
never hurts to just start over on the unwrapping. You learn from every mistake you 
make.  

Here's basically what I did...  

First I selected the body of the hand (both top and palm) and did a cylindrical map. 
Rotated, moved, and scaled the gizmo till it fit around the hand like in the image 



below.  

 

Next I selected all the fingers and did a planar map on them all at once.  

I Clicked the Edit button to open the edit winow. In the main viewport I selected the 
top of the hand and all the fingers like in the image below. The in the Edit UVs 
window, I Detached (Ctrl+d) the selected faces from the rest of the hand, flipped 
them horizontally, and moved them off to the side.  

 

In verticies select mode, I moved and target welded the palm and top of hand so that 
they were connected along one side (the side opposit the thumb).  

Then I did the same with the fingers, scaled the fingers down so they matched up 
with the palm of the hand and lined them up next to each other.  



 

 

I moved, and target welded the verticies until I had the whole body of the hand and 
the fingers combined together in one unit.  

 

For the thumb, I did two planar unwraps. It seems like a cylindrical map would work, 
but the thumb is just such an odd shape and curves in an odd fashion that it makes 
the cylindrical map more of a headache to deal with then just combining two planars.  

Don't worry if edges don't line up very well, and don't be afraid to move things 
around a lot. They'll still look okay in the final texture as long as you keep the 
general size and shape os the faces close to their original unwrap.  



 

 

Once I had both the hand and thumb unwrapped, I combined them together to 
reduce the number of seams. It's best if you can get the top of the thumb/hand 
combined together and leave the seam in the palm since it won't be as visable there.  

 

Once I was finished, I used the freeform tool to scale the hand to fill the entire box. 
The hand is really stretched by doing this, but my intention is to have the hand be a 
rectangle rather then a square texture.  

To do this, in the Render UVs window, I enter the dimentions 256x128, and when I 
click the Render UV Texture button, the map it generates is rectangular instead of 
the stretched square.  



 

Hands are done! All that's left is the head.  

Once again - same-o-same-o. Select the head, put on an UnwrapUVW modifier, 
expand the + and choose Face selection mode, select the whole head and click the 
cylindrical button.  

Move, rotate, and scale the cylindrical projection gizmo using the normal move 
rotate and scale tools, until the checkerboard texture looks best.  

 

Click the Cylindrical button again to deactivate it, and click the edit button. By default 
it will look something like this:  



 

To conserve texture space, we'll be wantind to mirror the whole head. If you really 
need to do some asymetrical texture work for the head (like if the character had a 
big scar or something) then you may want to leave some areas un-mirrored. But for 
this, we're just going to mirror everything that can be.  

So switch to vertex selection mode, select half the back of the head, Detach (Ctrl+D) 
Flip it horizontally, and move it over top of the other half of the head.  

We also need to avoide any over-lapping areas. The ear has several parts that 
overlap others, so just grab the verticies and pull them outwards so that nothing is 
overlapping anything else.  

 

Now do the same thing for the face. Select down the center, detach (Ctrl+d) flip it 
horizontally and move it over top.  



 

When I mirror UVs, I usually select everything and do a Ctrl+W to weld the two 
halves together. You need to be careful when doing this in areas with lots of detail to 
the mesh (like the face).  

If I selected the face and did a Ctrl+W it actually welds together some UVs that it 
shouldn't! This causes nasty distortions in the unwrap. So be careful to watch for 
problems like this!  

 

All that was left after this was to adjust the top of the head so that it would deform as 
best as I could get it to. My intention is to do some polygonal hair with opacities, but 
when I do it that way, I still find it a good idea to have a hair texture on the scalp 
under the hair.  



I also flipped the whole head because I'm just used to working on them in this way. 
So just fit the head into the square, render out the texture (Tools > Render UVW 
Template) set the size, click the button, save the file, close the edit window, and 
collapse the stack! Done! Fwew!  

 
So these are the unwrap textures I've saved at this point:  



 

 

Setting up the photoshop file with UV ref 
I'm going to explain two ways you can do this... I can think of at least two more in 
addition to these I'll explain. (It's amazing how you can do most anything in 
photoshop at least two or three different ways....)  

If you didn't save with an Alpha / Didn't use TGA format  

1. Open the file in Photoshop 
2. Click on the Background layer and drag it to the new layer icon (this will 
duplicate the layer). 
3. Go back to the background layer, set your background color to white, Select All 
(Ctrl+A) and Delete (del). 
4. Go to the Background layer copy. Choose Image > Adjust > Invert. 

5. Choose the Magic Wand tool and in the menu bar along the top of the screen 
uncheck anti-alias, uncheck Contiguous, and set Tolerance to 0. 
6. Click anywhere on the white part of the image and Delete. 
7. Rename the layer to UVs or something similar.  



If you saved your images as TGA files 
with Alphas (32-bit) 

1. Open the file in Photoshop. 
2. On the Background layer, select all 
(Ctrl+A) and Delete (Del) and it will 
replace the whole thing with whatever the 
background color you have selected 
(prefereable white right now). 
3. Go the the Channels tab. You should 
see 5 chanels, the RGB, Red, Green, 
Blue and an Alpha channel. Hold Down 
Control and click on the Alpha Chanel. 
4. Go back to the Layers Tab, Create a 
new layer . 
5. Select BLACK as your foreground 
color, right-click in your image anywhere and choose FILL from the drop-down. 
Go back to the Channels tab, click on the Alpha channel, and drag it into the trash-
can at the bottom of the channels window. 
This is just a precation, but it's a good idea to do it now rather then have something 
mess up later (if you load a texture with an alpha channel on it, in max, it may 
assume that you want to use that channel as the alpha and you could end up with 
some stupid headache when you render - just easier to fix it now to avoid a problem 
later).  

 

So now it should look like the image above. Name the new layer whatever you want 
(I usually go with UVs or UV Ref, or something along those lines).  

Now save the image as a PSD file. 

 

Texturing the Head  

The technique I'm going to cover here works for making a low-res real-time head 
texture. If you're intent is some high-res, high-poly head with a 1024x1024 res 
texture map, there are different techniques that I'd use. But when you're end result is 



gonna be small, there are some tips in here that will get a better result.  

Start by getting some photo ref. It's really best if you can find front and side views of 
the same head with the same lighting so you don't have to try to match the skin tone 
too much.  

This is the one that I've decided to go with. These images also came from 
http://www.3d.sk. Like I said at the beginning of the tutorial - this is a seriously 
awesome site full of reference and texture good-ness. I HIGHLY recommend getting 
a month's subscription and snagging as much from it as you can manage. It's so 
nice to be able to start texturing and not spend several hours googling and sifting 
through photos and textures on the net to try and find something almost useful. It's 
much easier to just open my local texture storage (basically a download of large 
portions of 3d.sk) and find what I need within minutes.  

 
 

First lets set max up with our work-in-progress texture. In 3dsmax open the Material 
editor and choose a slot that doesn't have any texture in it right now (blank gray 
sphere). Click on the box next to Diffuse and choose Bitmap from the window the 
pops up.  



 

From the select bitmat image file window, set the Files of Type: to All Files, or to 
Photoshop files. Either is fine, so long as you can find the PSD file with your UV 
template that you saved earlier.  

After you click Open, a PSD Input Options window will pop up. Just leave it on the 
defaults (collapsed Layers) and click OK.  

 

click the button in the material editor (in row of buttons along top, just under all 
the spheres) so that the texture will show in the viewport. Then Select the head of 

the character and click the assign button to assign the material to that object.  

Making the texture 
Go back to Photoshop now and click on the background layer so that you're under 
the UV ref layer.  



From your reference image of choice, make a selection around the eye, copy, and 
paste it into your texture work file. Right-Click anywhere in the image and choose 
"Free Transform" to be able to quickly scale and rotate etc. the pasted image.  

Move and scale the pasted eye so that it lines up with the UVs of the character's 
head. Next go back to your reference image and make a selection around the nose, 
copy, and paste it into your work image.  

 

I copy each piece of the face seperating because it gives me more control over 
scaling and moving those parts to line up properly to the UVs. It's rare that you'll be 
able to copy an entire face onto your UVs and have everything line up and be the 
right size, right off the bat.  

While doing this, Save your image and go back to 3dsmax to check on the 
placement of things. It should refresh the texture automatically every time you save 
your PSD file.  



 

Do the same thing for the mouth and check your progress in Max. Make sure that 
the mouth actually falls in the correct parts of the geometry on the 3D model. If it 
goes too far past the lip or doesn't line up with the crease between lips, bo back into 
photoshop and scale/move things around some more.  

 

Once the majority of the face is down, I copied the side angle of the head and scaled 
it so it was approximatly the correct size and shape. Now to open one of photoshop's 
most helpful tools when making textures from photo reference....  



 

Liquify  

Go to Filter > Liquify... (Ctrl+Shift+X) and wait a moment for it to load (it always takes 
a bit). 
First thing you'll want to do is check the Show Backdrop option, Use: All Layers, 
and Mode: Behind.  

 

The image below has all of the important areas circled. You'll just use the default 
tool, but you can feel free to experiment with the others. The great thing about 
Liquify is that it lets you nudge around things without bluring the image. The brush 
size is really sensive. Change the brush size as needed and move stuff around.  



 

When you're done in Liquify, just click OK and it'll update your main work image in 
photoshop. Save and check stuff in 3dsmax to see if anything needs nudging in 
different locations. I did this and I saw that the ears were still a little messed up, and 
the hair line needed some work.  

 

So I went back to photoshop, did Liquify again, and adjusted the shape and 
alignment of the hairline so that it'd display better on the actual model.  



 

Okay, now its time to clean up some of these overlaps. Often times, using the Erasor 
with a fuzzy brush, and going over the edges of each layer is enough to blend things 
together quite nicely. If you need to, you can use the Clone Stamp Tool as well.  

 

And another save and check in 3dsmax. Everything seems lined up good. The 
forehead still needs some work, but I can clean that up later when I start doing 
manual touch-ups. I decided that the eye layer could probably be stretched a little bit 
in width (eyes looked a little small anyways) and it'd fill that annoying gap without 
having to mess with the clone stamp tool.  



 

At this point I copied the neck from another reference image, and the back of the 
head from yet another. Use Liquify where needed to nudge things into place, and 
erase to smooth the transition between layers.  

 

The picture that I had as reference for the back of the head was actually taken from 
a different person and the skintone didn't match. It's common that you'll have to 
piece together the facial texture from several sources and getting the skin from each 
piece to match can be a real pain. But there's one quick trick I've found that works 
most of the time.  

Ok, so you've pasted the piece onto a new layer. Go to Image > Adjust > Match 
Color and a window will come up. In the bottom portion of the window is Source and 
Layer. From the Source drop-down choose the image you're working on now. Now 
from Layer pick a layer that you want to match.  

Since the layer I added had hair, and skin, I want to match it to another layer that 
has both hair and skin (the one I sampled from was the forehead/top hairline). This 
way it will match better.  

If you need to, adjust the Luminance, Fade, etc. Match color doesn't always work, 



but it usually gets pretty close.  

 

So just continue grabbing pieces of photo ref, use match color and Liquify when 
needed, and check 3dsmax frequently to make sure things are matching up.  

This is the base texture I ended up with. At this point I *could* be done. But I'm not. 
Now I'm going to go in and manually paint in some details, sharpen some areas, and 
apply general touch-ups all over. Since this is a low-res texture, and the character 
will usually be seen from a distance larpening some features usually gets a better 
result.  

 

At this point, I selected all of my face layers and merged them together. I created a 
new layer ontop of it (but still below the UV ref layer) and selected the Painbrush 
tool. In the options set the Opacity to around 50% and choose one of the solid round 
brushes.  



 

Holding down the Alt key will switch your tool to the eyedropper so you can pick 
colors quickly and easily. While painting you will frequently need to pick colors from 
the image so just keep your finger on the Alt key for easy switching.  

The texture as it currently is, is freaky on the forehead when I actually check it in 
3dsmax, so the first thing that I touched up was the forehead.  

 

Hold down Alt and pick up some skin tone. Now just paint over the problem areas 
with larger brushes. Since the brush is set to 50% opacity, you can get in-between 
colors by doing a singe brush pass over an area, and then using Alt to pick the new 
color. Do this over and over and make layers.  

For smaller details switch to a smaller brush size. I defined the hair line by just 
picking a black-ish color from the hair and painting in better hair roots.  

After the forehead, I turned my attention to the eyes. Using the eyedropper I picked 
the 'white' of the eye. But then I went into the color picker and wen brigher (still not 
actual 'white' but a ligher color then the one there) and painted in the whites of the 
eyes better.  

I picked ligher skin tones and increased the contrast around the eyes and the 
wrinkles, and I sharpened up the eye brows.  



 

I checked the progress in 3dsmax and deiced I still needed more definition to the 
forehead. Went back in and did some more touch-ups to the hair line and checked it 
in max.  

My plan is to make some alpha poly hair once I'm down with all the textures, so this 
is just the underhair, but it still needs to look good on the edges and hairlines.  

As another example, just compare the eyes of this version with the texture before 
any manual touch-ups (just above). The eyes stand out much more now. So even 
small touch-ups can make a big difference.  

 

Touch-ups on the nose and lips can make a BIG difference in the final look so 
they're important.  

Usually the first thing I do is fix the nostrils (they usually aren't shaped correctly to 
appear in the right location on the actual model. Just make adjustments, save, 
check, and repeat until they look correct in max).  

I made the base/underside of the nose darker, increased the contrast between the 
bridge of the nose, and the shadow on the sides of it. I adjusted the highlights on the 
outer nostrils, and drew in the crase where the outer nostril meets the cheek.  

For the lips, I find it's best to make the top-lip almost solid dark. I drew in highlights 
along the top of teh lip, and the highlights on the lower-lip. I also darkened up and 
created a more solid border below the bottom lip.  



 

I find that I often get better results on skin if I use a small brush (usually the solid 
round 3) and 'scribble' in some areas. You don't want a really smooth look on the 
skin because it'll look fake.  

Again - save often and check your progress in 3dsmax. Already the face is looking 
much more defined then it was before the touch-ups with minimal work.  

 

At this point I just finished up the rest of the head. I did a lot of touch-ups on the 
ears, since they weren't lining up perfectly with the model, and defined the hair 
better. I also went in with a ligher color of the hair and added highlights.  



 

Since the plan is to make poly hair later, all that I really care about is if the hair 
edges look correct, but its still good to get it all looking as good as possible.  

 

The last thing I do to any texture for low-res real-time is apply sharpen to it. Flatten 
the image and go Filter > Sharpen > Sharpen. Then go to File Save As.. and save 
your texture as a .tga or whatever format you want to use for the final texture.  

When you go back into max, edit the material for the head (click on the box next to 
diffuse and change it from the psd to the new flattened image you just saved).  



 

Comparring the end result now with the way the head looked before I started any 
manual touch-ups really makes it obvious how big a difference it can make.  

 
 

Onto the Clothing  

I do clothing differently then I do faces. I lay down a base texture and it's usually 
extreamly plane and flat. I'm not looking to get any shades or wrinkles in the base 
texture. Just the actual 'texture' of the fabric, and maybe things like seams, pockets, 
zippers, etc.  

Once my base is down, I go in and paint in the wrinkles using multiply and screen 
layers, which I'll cover later.  

Okay, so I'm moving onto the pants next because I know exactly what I want for 
them (jeans). Good reference images are very important to make jeans actually look 
like jean. Getting that "jeans" look is not hand-painted easily. I had these images that 
I used to grab my textures from. Again - they came from http://www.3d.sk! Haha - I'm 
a walking advertisment for this site, I swear... But this just goes to show that it's 
worth a subscriptions. Every texutre I've used on this guy was from that site, so I 
highly recommend it.  



 

The image may be of a jean skirt but it actually made it even more perfect since it 
has a lot more surface to grab texture from.  

Open the UV layout texture for the pants, set it up just like we did with the head so 
that your UVs are on a seperate layer with a blank background and save it as a .psd 
file. In 3dsmax open the material editor (m) and setup one of the blank material slots 
so that it's pointing to the psd file you just saved and apply that material to the legs.  

Back in photoshop, copy portions of the jeans and edit it so it fills the whole 
background of the image. After I'd managed to get a solid backdrop of 'jeans' cloth, I 
started copying in seams and other details.  

 

Remember, if you are having trouble lining anything up with the edges/seams of 



your UVs, that you can use Liquify (Filter > Liquify) to nudge/curve parts so that they 
fit better.  

I found myself frequently sharpening things as I copied them in and scaled them. 
Especially the seams.  

 

Like I said earlier, we are not aiming for any cloth wrinkles here - Not yet! So try not 
to get too many of those. We just want a simple base to work from.  

 

Remember to check your progress in 3dsmax to make sure you're lining things up 
correctly. Make sure you're getting the seams in loctions that you actually like and 



make sure things aren't being stretched/squished.  

 

Once the base is done, I start painting in the wrinkles.  

I start by setting up my layers. I create (at least) two new layers above all my jeans 
and seam layers. I have a Highlights (HLs) layer and a Shades (Shds) layer. I set 
the HLs layer's Mode to Screen and the Shds Mode to Multiple.  

 

When a layer's mode is set to screen, you can paint with solid colors, and it makes it 
look more like you're using the dodge tool directly on the layer. The bonus is that you 
can use smudge, etc. on what you paint, without messing up your base texture. 



Screen brightens, Multiply darkens. That's the basics. You paint with shades of 
grays/tinted grays to vary how dark or light it makes it. Pretty simple and very useful.  

 

I find it's best to have a reference when painting cloth wrinkles. You'll have a much 
better idea of what to aim for and where to put things if you have a real-life equivilant 
to look at as reference. I had this image (above) open on my secondary monitor 
while I painted the wrinkles in photoshop.  

 

I start out very messy. Scribbles to lay in my plans. You can also use this as a quick 
way to check to see if things are going to look correct in max. Get down the basic 
idea first, save, check 3dsmax and if somethings not right, you haven't done too 
much work yet, so its not such a big deal to go back and change/fix anything.  



Use darker tones (like a dark gray-blue) on your Shds (multiply) layer and don't be 
afraid to vary it some. Pick a ligher shade of dark blue-gray for some details, and 
add in darker shds in bigger wrinkles.  

Then I go in with the Smooth tool and blend things together better. I smooth out the 
scribbles so that they look like actual clothing wrinkles, save it and preview it in 
3dsmax.  

 

So once I checked out my work in max, I found a couple areas I didn't like. I didn't 
like the wrinkles in the knees or the way the cloth looked on the thighs so I went 
back and fixed those up.  

Then I moved onto the back of the legs. I use a different reference image (same 
model, just a rear view) so I'd get better cloth folds.  

Again - messy quick strokes to lay out my plans and get things to a point where I can 
check in max to make sure they're lining up properly.  



 

Smooth it out, check max, make any adjustments you need to make. I actually felt 
that it had slightly too much contrast so I reduced the opacity of the HLs and Shds 
layers. When you're good and done flatten the image (Image > Flatten Image), apply 
a sharpen to it (Filter > Sharpen) and save it as a .tga or similar format.  

 

Moving on to the shoes  

Open the UV Rendered texture for the shoes and set it up just like the others (set 
the UVs up on their own seperate layer, rename it, and save the file as a PSD). Set 
up a material in max for it and assign it to the shoes.  

Once again, the photo ref you can find will play a big role in getting a good result. 
With the shoes, I laid down a base from photo ref, but ended up painting over almost 
all of it, using the photo base as a reference and color pallete.  



 
Click to enlarge 

Pretty basic idea - just copy the reference images, move, rotate and scale them so 
that they're located as close as possible to where they need to be.  

 

Shoes are a prime example of Liquify being super-useful. Go to Filter > Liquify and 
nudge, push, and pull the shoe so that it more acurately matches the UVs. You'll 
need "Show Backdrop" checked, in order to see the UVs to match.  



 

Copy the other parts of the shoe into place, use the clone stamp tool where needed 
and use liquify to get things into place better.  

Once you have the whole shoe covered in texture, check 3dsmax to see how things 
are lining up. Because of the way the UVs are setup you are going to have a very 
noticable seam along one side of the top of the shoe. This is someting you'll need to 
take into account as you continue to work, and when you're painting over the 
reference images. You'll have to make sure that the exposed edge of the top shoe 
UVs matches the side that's connected to the rest of the shoe.  

 

For the bottom of the shoe I once again used the Liquify filter to get it to actually line-
up with the bottom shoe UVs. Once I was done with laying out all of the shoe's base 
textures I filled the background layer with a dark grey from the shoe and created a 
new texture on top of everything (but below the UV reference).  



 

Okay, once again I used the paintbrush tool with a solid round brush, and opacity set 
to around 50%. I used a larger brush at first to get in some larger areas of color on 
the trouble areas like the tops of the foot, and the toe of the shoe. I used a smaller 
brush (usually size 2 or 3) from then on though. For the seams I highly recommend 
going on another new layer and after you've painted in some of the seam edges, do 
a Filter > Sharpen > Sharpen on them and you'll get good results. To get the noise I 
want in the final texture, I used a lot cross-hatching sort of coloring. I also painted in 
the laces manually myself.  

Remember to pay attention to the exposed seam and make sure it lines up correctly 
in 3dsmax.  

 



 

When I was satisfied with the texture, I flattened it and scaled it down. The image 
that I created my texture at was 256x256 but my final image was half that. Image > 
Resize Image and change the values to 128x128. Now I applied a Sharpen (Filter > 
Sharpen > Sharpen) and saved it as a .tga file.  

The shoe geometry is much smaller then the rest of the model so it really doesn't 
need a texture the size of the rest of the parts, but I still prefer to make the texture at 
a higher res and then size it down to get in more detail.  

 

Okay, onto the jacket  

I did the shirt a lot like I did the pants. First I laid down a base texture layer with no 
shades or wrinkles, etc. Put in details like pockets and a zipper, and once I had that 
done, THEN I went in and added wrinkles the same way I did the pants.  



 

I did do one thing significatnly differently with the torso then I did with the pants. I put 
seam detail myself to emphasize the seams. After making the base texture above, I 

switched to the Pen Tool and drew in lines for all the seams. They'll be on their 
own layer so Create a new layer above your base texture and choose a darker color 
from the image and then in the color picker make it even darker. This will be the 
color of the seams.  

 

Pay attention because if you've never done this, it's easy to miss this and get 
confused. Right now the lines are just vector paths. They aren't actually apart of the 
image yet. We are going to "Stroke" the paths with the paintbrush tool. But first we 
need to set the paintbrush tool the way we want it. So go to the paintbrush tool, set 
the brush size to 1 or 2, and set the opacity to 100%.  

Now select the pen tool again and Right-Click anywhere in your image and choose 
Stroke Path from the drop-down.  

From the window that comes up, choose Brush from the drop-down, make sure that 
simulate pressure is NOT checked and click OK.  



 

Now we're going to make the highlights around the seams. Right-click again and 
choose Delete Path from the drop-down. Now with the pen tool draw in a few areas 
where there would be highlights on the seams. Create another new layer and set 
your current color to a ligher version of your main color (near white-ish if nessecary) 
and stroke the new paths.  

Once I was happy with the seams, I created two new layers, a Shds and HLs layer. 
(Shds Mode set to Multiply, and HLs Mode set to Screen) and began painting in 
wrinkles just like I did earlier with the legs.  

Having a reference of what the wrinkles should look like well be very helpful here so 
if you can find one, that's best.  

 

Just like with the pants, I started out with rough scribbly marks to get the shape 
started and laid out. Then I went back in and smoothed them out. The jacket has a 
seam that you need to watch for. Since the front isn't mirrored (to avoid overly 
obvious symmetry in the texture) one side is exposed here. You'll need to make sure 
that the seam on that side of the short isn't too obvious.  



 

Once I had the shds in place, I put in the highlights. Same as before - scribbly 
placeing and then smoothing and putting in details.  

 

Once I was done with the shades and highlights I did an extra step. I created 
another layer above them all and picked a dark grey / grey-bluish color and painted 
in around some of the darker shaded areas, and then went in and smudged them to 
blend it with the colors behind. This was just to give it some better color depth.  



 

Now to do the arms..  

Since the arms are a part of the jacket, you should make sure to do them very 
similar so that they flow together. So you'll use a lot of the same base texture on the 
sleeve that you used on the torso, and do yoru shades and highlights in the same 
color/lighting.  

 

 

Same as all the other things. And when everything is done, save it as a flattened, 
sharpened, tga file and update max again.  



 

And finally the hands  

The hands will be like the shoes. I used photo reference on the bottom, but it was 
mostly just for color and basic reference. It's very diffcult to get photo referenced 
hands to line up properly with boxy, low-poly unwrapped hands, so most everything 
will end up being hand-painted. Here's pictures of my process:  

 

First I filled the outside of my UV ref with a skintone so I could see better where the 
fingers were.  



 

I copied, moved, scaled, and used Liquify to get a palm and hand-top into basic 
locations.  

 

Then I created layers overtop of all that and painted the hand texture. The images 
below made good reference for color, etc. but hardly any of it is showing through in 
the end.  

 

And when I was finally finished, I sharpened the whole image.  

 
 



Hair 

Okay, first off, at work we don't actually have hair like this. Our hair is very basic and 
usually just painted directly onto the head itself. Simple short hair cuts. With women, 
even then the hair is usually a part of the head mesh and painted directly onto the 
head texture itself.  

But I'm making this tutorial for a more fancy kind of hair because it's something I get 
asked a lot.  

This is just one possible way to make hair. There are many different ways to 
approach making hair, and there is no One Right Way to do it. Just many options 
depending on what your end goal is.  

 

First I made a new document in photoshop; 256x256. I got some photo ref of some 
hair I wanted to make it look like and pasted some bits into the new window.  

Use the Liquify filter (Filter > Liquify) to move anything around that needs moving.  

I painted below the hair bits first to match the general color and then created a layer 
above the hair and painted with a small brush and around 50% opacity.  

 

Just keep painting in details and strokes. Use the images as reference.  



 

Basically I make several shapes of hair that I know I'll want to use in different 
locations on the head. It's good if you plan out the hair style and the sort of shapes 
you'll need before you start all this so that you can make the texture fit what you 
want.  

Once I had the base hair texture done, I used the pen tool to create the basic outline 
of the shape.  

 

When you've got the shape done, right-click in your image and choose Make 
Selection. Go with the defaults on the window that pops up )Feather Radius should 
be 0) and click OK.  

Now go to the Channels tab and click the Save Selection as Channel button (circled 
below).  



 

It should create a channel called Alpha 1. The background should be black, and the 
area you had selected should be white. Click on the Alpha channel to activate it. You 
can paint directly on the channel with the paintbrush tool just like a normal layer, 
except it will actually be affecting the opacity alpha instead.  

Use the paintbrush tool with opaicty around 50% and with small brush size and 
modify the hair's alpha to be more 'hair like'.  

 

To go back to viewing the regular image, just click on the RGB channel. If you make 
additional selection with the pen tool and then convert to a selection you can add it 
to your existing alpha by just selecting the alpha channel, setting your color to white, 
and choosing Image > Fill.  

Once your texture is done, Flatten it (Lyaer > Flatten Image) and save it as a .tga 
file. IT IS IMPORTANT that you save it as a .tga file. Tga files save alpha 
information, so it will keep the black and white alpha channel you created.  



Now go to 3dsmax and open the material editor (m) and pick an unused slot (one of 
the grey spheres). Click on the box next to Diffuse and choose Bitmap, just like 
before. Find your TGA texture and click ok. Now go back to the material main 
options (click the button circled in the image below)  

 

Check the 2-Sided option, and then scroll down to the rollout for +Maps and expand 
it.  

 

In the Maps rollout you should see the Diffuse Color has a Check next to it, and lists 
a map. All of the rest should say None under Map. Click on the Map button for 
Diffuse Color and Drag it to the button next to Opacity that says None.  

 



A window will pop up, make sure you set it to Copy, not Instance.  

Now Click on the new map in Opacity and it will let you go in and edit it.  

 

Set the Mono Channel Out put to Alpha, and set the Alpha Source to Image Alpha. If 
these options are grayed out that means that the alpha channel didn't save with 
the TGA file. Go back to photoshop and make sure it saves correctly.  

No go back to the main material settings and click the Show Map in Viewport 

button  

Now I changed my view to the Front view and went to the create tab and made 3 
plans with 0 segments.  

 

I assigned the hair texture I just made to all 3 planes. Switch to the Perspective 
viewport. If you just see wireframes hit the F3 button so you see the textures. If you 
don't see opacity Right-click on the word Perspective in the top-left corner of the 
viewport and go to Transparency > Best.  



 

All three planes should now show the entire hair texture on it with opacity. What we 
want to do is seperate it so that each plane only has one section of hair, instead of 
all three.  

Select one of the planes, right-click on it and choose Convert to > Editable Poly from 
the drop-down. Now go to the Modify tab and apply an Unwrap UVW modifier to it. 
Click the edit button and move the UVs so that it's only over one of the hair pieces. If 
there is a little overlap and some of the neighboring pieces is visible, that's ok, we'll 
cut it out in a minute.  

Once it's all set, collapse the stack.  

 

Repeat this on all three segments. For any areas where there is overlap and you can 
see portions of one of the other pieces, go into vertex selection mode of the editable 
poly, and use Cut to cut the plane so that it's closer to the shape of the hair piece. 
Select and Delete any polys on the edge you don't need anymore.  



 

Now, use Cut to cut horizontal lines through the hair. You'll need several close 
together at the top near the hair line since this portion of the hair will need to be able 
to curve more tightly then the rest.  

Next do a one or two verticle cuts as well.  

 

Now select all of your hair pieces, right-click on them and choose Object Properties 
from the drop-down. In the window that comes up find the Display Properties (left-
hand side of window) and make sure that Backface Cull is unchecked.  

 



Now is the hard part that will involve a lot of tweaking and adjusting on your end. 
There is no real step-by-step for this that I can give you, you'll just have to go with it 
and keep messing with it until it actually looks right.  

Select one of the pieces of hair and Hold Down Shift and move it over by the head. 
This will Duplicate the object, instead of actually moving the orignal.  

It's important that you leave your original un-altered base objects to the side so you 
can pick from them whenever you need to.  

On the new duplicated hair piece, move, rotate, and scale it into place near the 
head, and then start moving verts to get it into a shape and location you like.  

Now repeat this over and over with each of the pieces until it looks good. :P  

Cut in / Connect to create new edges whenever you need to.  

Build up layers of hair to get more depth.  

 



 

Work your way around the whole head.  

 

You'll probably be constantly going back to fix and adjust the placement of various 
hair pieces until it looks right.  

 



And just keep working on it until it looks the way you want it to. It can take patience 
and lots of tweaking, or it may just work from the get-go. It will vary.  

It really helps to have a clear hair-style goal in mind, and a picture reference is 
always a big plus.  

 

That's it! I rigged him, but I'm not going to do a tutorial on rigging... At least not now. 
Hope that this tutorial helps someone. If there was some point in the tutorial where I 
said "now click on ..... and blah blah blah" but never explained where ..... was or how 
to find it and you got totally stuck, just send me a line (and mention where it was you 
got stuck) and I'll fill you in, and fix the tutorial :P  

I know there are typos and spelling errors and I don't care, so don't email me about 
them. I wrote this tutorial in Windows NOTEPAD... no spell check. And it's really long 
and it's too much of a pain in the ass to try and fix it now, so live with it.  

Umm... that's all I can think of. Questions, comments, praise, and curses can be sent 
to atheynm-at-gmail-dot-com.  
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